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Getting started

Compatibility

* This version of Discover™ can analyse files from Acquire™” 2024R2 or earlier and open saved results
from Discover™® 2024R2 or earlier.

» TDMS files are no longer supported. Refeyn’s tdms_to_mp_converter application can be used to con-
vert TDMS files into .mp files. To download this application, visit https://refeyn.filecamp.com.

Installing/updating

If installing Discover™" for the first time, jump to step 4.

. Make sure all instances of Discover™ are closed.

. Uninstall the old version of Discover™" by going to Control Panel > Programs > Programs and Features
and then selecting Discover™ to uninstall.

3. Check the uninstall has been successful by going to C:\Program Files (x86) in the Windows file explorer
and checking that there is no folder called DiscoverMP. If there is, manually delete the folder.

4. Execute the Discover™ setup executable file (the filename will be like: DiscoverMP_v0.0.0_setup.exe).
Double clicking on the file will bring up an install wizard.

5. Follow the steps of the installer, making sure to read the terms and conditions before accepting.

6. Once the installer has been completed, the software is ready to use.

N =

Multiple displays

When using multiple displays, the settings must be correct to avoid issues with the application’s layout. The
most common issue comes from having different zoom factors for each display. To make sure this does not
happen, each display must be set to the same zoom factor. This can be done by going to Settings > Display
and selecting the same scale factor (ideally 100%) under Scale and layout for each of the displays found
under Rearrange your displays.
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https://refeyn.filecamp.com/

Settings

f Home D|Sp|ay

Find a setting Rearrange your displays

System Select a display below to change the settings for it. Press and hold (or select) a display. then drag to rearrange it.

L Display
91 Sound
Natifications & actions
Focus assist
Power & sleep
Battery Identify

Storage

Brightness and colour
Tablet

Night light
f Multi-tasking @D o

Projecting to this PC Nig

Colour profile
Shared experiences
HP E24q G4 Monitor ~

System Components

EipEcand Windows HD Colour
Remote Desktop

Optional features

About
o Scale and layout

Change the size of text, apps and other items

Figure 1: Selecting display scale for multiple monitors

End User License Agreement (EULA)

When Discover™ is run for the first time, it will display Refeyn’s End User License Agreement. Make sure

to read the terms and conditions before accepting. In addition, a choice for Discover™’s telemetry mode is
shown with the following options:

* Feature preview mode
¢ Normal mode
¢ Offline mode

The details of each mode are listed to their right. Accepting will also confirm the current selected telemetry
mode, this can be changed in Preferences.
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carefully read our End User License Agreement

REFEYN MASTER SOFTWARE SUBSCRIPTION LICENSE AGREEMENT

This Refeyn Master Software Subscription License Agreement (this “Agreement”) 1s a legal
agreement between you and, if applicable, the company or other legal entity you represent
(collectively, “Licensee” or “you”) and the relevant Refeyn group entity specified in the terms and

conditions (“T&C"™) with the Licensee (such group entity is referred to as “Refeyn™).

PLEASE CAREFULLY READ THIS AGREEMENT BEFORE DOWNLOADING,
INSTALLING OR OTHERWISE USING THE COPY OF THE SOFTWARE PRODUCT
CONTAINED IN THE DOWNLOADABLE FILES OR SOFTWARE MEDIA PACKAGE (THE
“SOFTWARE™) OR ANY RELATED DOCUMENTATION (*“DOCUMENTATION™). IF YOU
DID NOT PROPERLY OBTAIN THE SOFTWARE FROM REFEYN OR AN AUTHORIZED AGENT
OF REFEYN, YOU ARE NOT AUTHORIZED TO DOWNLOAD, INSTALL OR USE THE

Feature preview mode

@ Normal mode

Offline mode

Reject terms ‘cept terms

Figure 2: End User License Agreement and mode selection

Licensing

When you open the application for the first time the program will prompt you to activate your licence with
your licence key. The licence key is normally provided with the software, and looks like ABCDE-FGHIJ-
KLMNO-PQRST. If you do not have a licence key, one can be obtained by contacting Refeyn using sup-
port@refeyn.com.

If the PC on which you are installing Discover™” has an internet connection, make sure Use this PC’s
internet connection is selected, then simply enter the licence key into the box and click Finish.

If the PC does not have an internet connection or the connection fails, choose Use another PC’s internet
connection, then enter the licence key into the box, click Next and note down the machine code shown in
the dialog. Next, on a different PC with an internet connection, open the webpage shown in the dialog. This
will load a form in which you should enter the machine code and your licence key. On clicking Activate, an
.skm activation file will be downloaded. Copy this file onto the PC on which you wish to activate Discover™".
Enter your licence key into the Discover™” dialog and use the Browse button to select the .skm activation
file you copied over, then click OK. Discover™ can now be run.

Refeyn Discover™” User Manual e Page 6



Deactivating the licence

If you wish to move your licence for Discover™ to another PC, you should deactivate the licence on the PC
you no longer wish to use. To do this, open Discover™” and go to Help > Deactivate licence. A warning
message will be shown. Clicking Yes will close Discover™? and deactivate the licence on that PC. You can then
activate your licence key on another PC. To reactivate a licence after deactivating it, simply open Discover''"
again and re-register the licence, following the instructions above.

Main user interface panels

Figure 3: Main panels for data analysis

The main Discover™” window by default displays Measurements Panel and Calibrations Panel on the left-hand

side, and Analysis Panel on the right which, in turn, consists of the Histogram Panel, Histogram Variables Panel,
Selections Panel, Movie Panel, and Scores Panel. Further analysis features can be accessed in Figures Panel (see
Figure 16) and Tables Panel (see Figure 18) by switching from the Analysis tab to the Figures tab and the Tables
tab, respectively.

Managing a workspace and measurement files

Opening and closing a workspace

When opening Discover™?, the user will have access to a workspace where multiple files can be visualised and
analysed. To analyse a measurement file, just add it to the workspace and the analysis will start automatically.
There are three main types of measurement files that can be added to a workspace:
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* A mass photometry results file (.mpr) or a recording file (.mp) saved in Acquire™”

* A mass photometry results file (.mpr) saved (or exported) in Discover' v2.5 or later

To open a previously saved workspace, go to File > Open Workspace (or press Ctrl+O) and select the
workspace file (.dmp) of interest. This will open all measurement files, analysis and data associated with
this workspace.

To close a workspace, go to File > Close Workspace.

Legacy results folders

Legacy results folders were generated by Discover™ v2.4 or earlier. As of Discover™” 2024R2, loading these
folders is no longer supported.

There are 2 options for loading legacy results folders into Discover™':
* In one of the following versions of Discover', go to File > Open Legacy Results, or press
Ctri+Shift+O. This opens a file explorer dialog, where the results folder can be selected.

- v25

2022R1
2023R1
2024R1

* Load the original .mp file of each measurement to be converted into the latest version of Discover™?,

which will then be re-analyzed.
After following either method, the loaded measurements can be converted into .mpr files.

* To create .mpr files for all measurements, save the workspace (File > Save Workspace).
* To export indiviual measurements as .mpr files, right click on the measurement in the Measurements
Panel, then click Export > Results.

Managing files in a workspace

Adding files

To add a mass photometry results file (.mpr) or a recording file (.mp) to a workspace, press the + Open
button on the top-left corner of the Measurements Panel. Alternatively, when Discover™ is first opened,

there is also a + button in the central panel (see Figure 4). This opens a file explorer dialog. It is also possible
to simply drag a measurement file from filesystem onto the Discover™” window to add it to the workspace.
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@ Refeyn DiscoverMP - m] X

File Help

Measurements

-+ Open

To start analysis, please add one or more files to the workspace.

4

Calibrations @
—+ Open

Na calibration

Figure 4: Main window when first opening application

Once a measurement file has been selected, the data is loaded into the application. If the measurement file is
large, this may take a while to load.

Mass photometry results files (.mpr) are available immediately after loading. On the other hand, recording
files (.mp) have to first be analysed by Discover™”. The recordings are analysed one at a time, in the order in
which the files have been added to the workspace. While the file is being analysed, the background for that
measurement in the files panel turns into a progress bar.

' The maximum number of measurements that can be added to a workspace is dependent on
__ the computer’s virtual memory. The more files added, the larger virtual memory required.
~  If your computer runs out of memory, some data might be lost. VWe suggest no more than

e 24 files to be added to a workspace.

’

Selecting and visualising measurement files

To select a measurement file, click on its name in the Measurements Panel. When selected, the measurement
file’s name will be highlighted in yellow. To visualise the data associated with a measurement file, double-click
on the file’s name and the data will be shown in the Analysis Panel.
) ! ’
__ The measurement file displayed on the Analysis Panel will be highlighted in bold and have an
A=/~ arrow pointing to the Analysis Panel next to the filename.
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Removing measurement files

Measurement files can be removed from a workspace by selecting them and clicking on the Bin icon at the
top-left of the Measurements Panel. Alternatively, a measurement can be removed by either right-clicking on it,
or clicking the More button (three dots) and choosing Delete. Note that this only deletes the measurement
file from the workspace folder, and not the original measurement file that had been initially added to the
workspace.

Merging measurement files

Measurement files can be merged in a workspace by selecting the measurements of interest and clicking on the
Merge icon at the top-left of the Measurements Panel. This will automatically generate a new measurement
containing the merged data. Merged files will not have movie or movie quality score data available. For files
to be merged, the device, measurement mode, and image size need to be the same.

To enable mass mode for a merged measurement file, a calibration needs to be applied to each individual
measurement before the merge.

Data analysis

Mass photometry results files (.mpr) are ready to be worked with as soon as they are loaded into the
workspace. Files recorded with Acquire™” 2023R2 or earlier, or in the case live analysis has been explic-
itly disabled, are of the recording file (.mp) type. When such a file is added to a workspace, it is automatically
loaded and queued for analysis. To stop the analysis, click on the Stop icon at the top of the Measurements
Panel. The analysis can be started again by clicking on the Start icon at the top of the Measurements Panel.

Analysis modes

When recording movies in Acquire™ there are four modes available, Normal mode, AAV mode, Antibody
Stability mode and Samux mode; and one experimental mode, Fast detection mode. Depending on
the mode used, the functionality available in the Analysis Panel associated with that measurement file will be
different.

+ Normal mode: This is the default mode in Acquire™® for acquiring and analysing biomolecules when
using a One™?, Two™P, One™P Auto or Two™” Auto

* AAV mode: This mode should be used for measurements of AAV samples when using a One™P, Two™P,
One™? Auto or Two™P Auto.

» Antibody Stability mode: This mode is recommended for measurements which are to be analysed
with the Antibody Stability module in Streamline™”. It is available when using a One™?, Two™P, One™?
Auto or Two™ Auto.

+ Samux mode: This is the default and only mode in Acquire™” for measurements of AAV samples when
using a Samux""",

The following table shows which Discover™ features are available in which modes.

Refeyn Discover™” User Manual e Page 10



Normal Mode &
Antibody Stability

Feature Mode AAV Mode Samux Mode
Acquisition movie X X X
Data quality scores X X X
Histogram X X X
KDE X X

Contrast X X X
Calibrated value (mass, bases, or X X X
base pairs)

Acquisition plot setup X X X
Vertical lines X X X
Interval regions X X X
Automated peak fitting X X

Manual peak fitting X X X
AAV limits X X
Automated AAV fitting X
Spatial and temporal masking X X

Virus titer X

The Fast detection mode [EXPERIMENTAL] is available only on Two™" manual instruments, and is intended
for use in the MassFluidix HC system, with samples that are particularly unstable.

Acquisition visualisation and editing tools
Acquisition movies and scores

In the Analysis Panel, there are two different types of movies available: native and ratiometric.

Native movies: Native data acquired using Acquire™”.

Ratiometric movies: During analysis the ratiometric images are calculated. This involves dividing future
(time-averaged) movie frames by past (time-averaged) movie frames. During each of these operations, the
data that is common to both images is removed, leaving only the difference between each of the pairs of
frames. This is the ratiometric image which in turn comprises the ratiometric movie.

To see an overlay of the spatial distribution of all detected events, right-click on the Movie Panel and then
checking Distribution. A high quality measurement should give a roughly uniform spread across the movie.

In the Scores Panel, there are five options to choose from: Sharpness, Saturation, Brightness, Signal
and Motion. Swapping between these modes will display the corresponding value for each frame in the
movie.

The Sharpness value shows how precisely the sample was positioned and held in focus during the measure-
ment. The minimum recommended Sharpness value for the One™ and Two™ is 4%, and 1.6% for Samux"".
Please note that the value can be exaggerated by a dirty glass surface, giving the false impression that the
sample is in focus. In this case, the user is advised to move the coverslip to a clean region before starting the
recording in Acquire™”. Additionally, the sharpness value tends to decrease slightly with image size because
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the illumination profile is more uniform as the light is distributed over a larger area. During the recording
of a movie, sharpness tends to increase as particles bind to the surface. That is expected and no reason for
concern. However, a significant drop of the sharpness value usually indicates that the sample moved out of
focus, which may impact data quality.

The Saturation value shows the percentage of pixels in the movie that are saturated (ji.e. overexposed).
Ideally, this graph will be a flat line sitting at 0%. A small percentage of saturated pixels is tolerable but the
saturation value should not exceed 0.5%.

The Brightness value shows how much light the camera has detected in relation to its saturation level. This
indicates how efficiently the dynamic range of the camera has been used. A high brightness value (at least 25%
for One™P, 50% for Two™P, and 70% for SamuxMP) is desirable to minimise shot-noise in the data.

The Signal value is indicative of the amount of change in the data. Frames with higher signal usually show
particle binding/unbinding events. For a movie containing only a buffer measurement, this value should be
0.06% or lower. Please note that the choice of image size influences the signal level. As the image size is
increased the same amount of light is distributed over a larger area and therefore per-pixel noise increases.
Hence, the signal level for a clean buffer will tend to be higher for larger image sizes.

The Motion value gives an indication of the amount of lateral motion detected during the acquisition of a
frame. The value is calculated from the frame data by determining the amplitude of the motion signature
in the ratiometric frame. Small-scale motions are tolerable, but values exceeding 5% are considered to be
considerable motion and may impact data quality significantly.

Sharpness Saturation Brightness Motion

|
h M ;M Fl"llnl' il il r" \ T
il J\' "\Wﬂ\ﬂ"i'i"uﬂﬁ'\1',"f‘“ !‘l\i"'\u,J,l“".L'l'w“p\/ﬂqfUr,ﬂr i L'***11"1'#'M"J’*"J‘1H'“'“q’l""" "/f”lf’l"ﬂh’”a\J\n'w\’fv" l*r*‘fﬂ'l',*m,f il
| A

30
Time (s)

Frame Seconds  30.000 Speed 1.00

Figure 5: Score Panel

The frame shown in the Movie Panel can be changed by moving the vertical orange cursor along the x-axis of
the Scores Panel graph. To display a frame of a specific frame number or time value, select the desired unit
(Frame or Seconds) by clicking on the relevant option button under the score graph, and entering the value
in the field next to it. The movie can be played using the Play button. To change the playback speed, change
the value in the field next to the FPS or Speed label, depending on which units have been chosen.
1
__ You can move forward and backward through the movie by hovering over the Score graph
A=/~ and using the mouse wheel.
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Analysis plot types
Histogram vs KDE

For Normal, AAV and Antibody Stability modes, the main plot can be toggled between Histogram mode
and Kernel Density Estimate (KDE) mode. The buttons to switch the mode are found in the Histogram
Variables Panel, labelled Histogram and KDE. If you want the KDE mode to show an estimate of a Probability
Density Function, then check the Normalise button (the y-axis will be labelled “Normalised density”). For
Samux mode, only histogram mode is available.

Contrast vs calibrated value

The measurements can be calibrated into units of mass (kDa, MDa) or nucleic acid length (bases, base pairs)
(see the section in this manual on calibration). The histogram may then be alternated between showing
contrast and the calibrated value on the X axis by selecting the relevant plot in the Histogram Variables Panel.
If no calibration has been applied, only the contrast mode is available.

Analysis settings

Discover™ gives the option to change the analysis settings for measurements loaded into the workspace. This
will affect the behaviour of the event finding and fitting algorithm.

The default settings are tested on a wide range of conditions and samples and are known to produce reliable
results. Therefore, it is not recommended to deviate from the default settings. The ability to change settings
is initially limited to One™P measurements only, however this can be changed to allow settings to be altered
for any measurement in Preferences.

When changing the settings for a measurement, right-click on the measurement in the Measurements Panel
and click Settings.

The settings dialog allows the following settings to change:

* Number of Averaged Frames: number of (binned) frames that are used for signal averaging.

* Reflectance Correction: if enabled analysis compensates for the spatial contrast bias due to uneven
reflectance of the glass surface.

* Motion Correction: if enabled analysis compensates for contrast errors due to transverse translation
of the glass with respect to the optical system.

* Event Finding - Threshold 1: sensitivity adjustment for picking up event signatures in the temporal
domain (high values mean low sensitivity).

* Event Finding - Threshold 2: sensitivity adjustment for picking up event signatures in the spatial domain
(high values mean low sensitivity).

* Event Fitting - Use AAV (contrast-dependent) fit error metric: if enabled a metric is used to rescale the
fit error to avoid false AAV detections.

If new settings are confirmed for a given measurement, the measurement will be automatically re-analysed.
The default settings can always be reverted to by clicking Restore Defaults in the settings dialog.
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Mumber of Averaged Frames 5
Reflectance Correction
Motion Correction
Event Finding
Thresheold 1 1.200

Threshold 2 0.250

Event Fitting

Use AAV (contrast-dependent) fit error metric

Restore Defaults 0K Cancel

Figure 6: The settings dialog

Acquisition plot setup
Changing the limits

The plot axis limits may be altered in three ways:

* By manually changing the values in the Histogram Variables Panel
* By hovering over the histogram and using the mouse wheel:

Scrolling changes the y-axis maximum

Ctrl-scrolling changes the x-axis minimum
Shift-scrolling changes the x-axis maximum
Alt-scrolling translates the histogram along the X axis

* By clicking the two buttons next to the axis limit boxes to automatically set the axes to the maximum
values found in the data.

s« -, The Y axis maximisation button locks the Y value to always show the maximum value. So,

- @ = if other settings are changed, the counts/density axis will adjust to show all the data. The X

- ¥ axis does not update in this way.
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Bin width and bandwidth

In histogram mode, contrast values are binned into ranges of values (bins) and then summed within these bins
to calculate the number of counts shown on the histogram. The width of the bins can be varied by changing
the Bin width in the Histogram Variables Panel. The histogram is always split into equal regions with the size
of the bin width. The bin width units are contrast value (in contrast mode), or kDa, bases or bp (in calibrated
mode).

L | {
| g ﬁﬁ {
| s H

i i P

Figure 7: Two histograms of the same data with bin widths of 15kDa (left) and 3kDa
(right)

In KDE mode, bandwidth is analogous to the bin width and can be changed in the Histogram Variables Panel.
The bandwidth units are contrast value (in contrast mode), or kDa, bases or bp (in calibrated mode).

Normalise

The counts data can also be normalised by selecting the Normalised check box. This will divide the counts
in each bin by the total number of events. This facilitates easier comparison between histograms with differing
total numbers of events. In KDE mode, this button switches between plotting counts density (where the
area under the graph equals the number of counts) and plotting normalised density (where the area under the
graph equals 1, giving a probability density function).

Vertical lines

ini

The Vertical lines button can be found in the Histogram Toolbar. When it is selected, vertical lines can
be added to the plot by double clicking with the left mouse button on the plot or by dragging with the left
mouse button. In addition to the vertical line, a label will be added displaying the contrast/calibrated value.
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Dragging will draw a line at the median of the selected values (no line is drawn if there are no counts in the
region).

The labels generated from vertical lines can be moved to more favourable positions by dragging them with the
mouse. To delete a label and its corresponding vertical line, either select the label with the mouse and press
delete, or click the label while holding the shift key.

-0.00370

-0.00190

-0.00750

Figure 8: Vertical lines set at rough positions of histogram peaks

Interval regions

il

Adding interval regions to the plots provides information about events in the selected contrast/calibrated unit
interval. To add an interval region, click the Interval region button and drag with the left mouse button over
the desired interval. The selected region will then be highlighted and bound by pale yellow lines. Alternatively,
double-click on a peak to automatically fit a normal distribution and add an interval region about the detected
peak. The fitted region will be centred about the peak with bounds of +/- 2c. A label will also be displayed
which gives the median value of the region, the contrast/calibrated value bounds for the region and the total
number of counts for the region displayed as a an absolute number and as a percentage value compared to
the total count of binding/unbinding events (depending on whether the interval covers binding or unbinding
events).

The labels generated from interval regions can be moved and deleted in the same way as for vertical lines.
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Figure 9: Interval regions set over a couple of histogram peaks

Peak fitting

In histogram mode

In histogram mode, fitting a peak to the data provides information about peak position, peak width, integrated
counts, and skewness. Peaks can be fit automatically or manually.

Information about the fit is displayed above the curve in either contrast or calibrated value (mass or nucleic
acid length). The information displayed is:

* Mean peak value

* Width of the fitted peak (o represents the standard deviation)

* Sum of the number of counts under the fitted peak expressed as the number of counts and the propor-
tion of counts. (The proportion is defined as the number of counts compared to the total number of
binding/unbinding events depending on whether the peak is located in the binding or unbinding domain
of the histogram)

¢ Pearson median skewness of the curve;

— Skewness = 0: the mean and median are the same; there is a normal distribution
— Skewness < 0: the mean is smaller than the median; the outliers of the distribution curve are

further out towards the left
— Skewness > 0: the mean is greater than the median; the outliers of the distribution curve are

further out towards the right
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In KDE mode

In KDE mode, pressing the Peak fitting button adds vertical lines with labels at each local maximum of the
KDE plot.

Automatic fitting

M

Once analysis of a measurement is complete, peaks will be added automatically to the data (except for Samux
measurements). The peaks can be manually deleted as with all other peaks. If you have removed your peaks,
or you have a Samux"" file, you can add the automatically generated peaks by pressing the Automatic peak
fitting button located in the Histogram Toolbar.

MP

The automatic peak fitting can produce non-normally distributed peaks as it tries to fit to all of the data
present. The non-normally distributed peaks are easy to distinguish as they will have a non-zero skewness
value.

Manual fitting

i

To fit a Gaussian peak, first select the Guassian Fit button from the Histogram Toolbar, then either drag
with the left mouse button over a contrast/calibrated value interval or double click near the centre of the
desired peak.

More than one peak may be fitted at the same time by selecting multiple regions in the graph sequentially. If
a new region impinges on an existing Gaussian fit, the new peak fit will replace the previous one.

The labels generated from gaussians can be moved and deleted in the same way as for vertical lines.

__ Avoid dragging the peak fit range across an adjacent peak as the fitting routine will only fit to
A=/~ the newly selected peak.

Applying overlays to other measurements

=% Apply to

Use this button to apply the gaussian fits, vertical lines and interval regions to other measurements in the
workspace. Before the overlays are applied, plots are cleared and the plot settings are changed to match the
settings of the currently opened measurement.

N 4
" This feature is only available when Feature Preview mode is selected in Preferences.

\
-—
-
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AAJV regions

There are two modes to apply AAV limits to measurements. In Manual mode, the user determines where
to place the empty, partial, full, and overfull bounds. In Automatic mode, an algorithm locates the regions,
based upon the expected mass of the capsid and the transgene length.

There are potentially four AAV regions; empty, partial, full and overfull. The empty region is the lower mass
peak representing binding events from empty capsids. The partial region can represent partially filled capsids
between the empty and full regions. The full region is the higher mass peak representing binding events from
full capsids. Finally, the overfull region can be used to accumulate all counts with a higher mass than the full
region. Overfull is not used in Automatic mode.

Common Procedure

To enable the AAV limits, load a calibration (which must also come from a movie recorded in AAV mode) and
analyse the AAV movie in Discover'™. Once the movie is analysed, the histogram will automatically switch to
mass mode.

Add the AAV overlay by toggling the AAV overlay button.

The AAV overlay has a label describing the details from the AAV overlay, which can be moved and deleted in
the same way as for vertical lines.

Manual Mode

Select the Manual mode radio button.
Each of the four regions is activated and deactivated with a check box in the AAV Limits panel.

The AAV overlays can be edited in multiple ways:

* By dragging either edge of the region you want to adjust
* By dragging the entire region that you want to move
* By manually adjusting the values that are visible beneath the histogram in the AAV Limits panel

The AAV limits can be saved and used in later sessions selecting the Save button on the AAV limits section.
AAV limits saved will be available on the drop-down menu above the AAV limits section. When selecting Apply
to all, the AAV limits selected will be applied to all measurements opened in the current workspace.

In manual mode, the AAV limits can range between 2,000 and 10,000 kDa. The mass range of particles that can
be measured varies depending on the mass photometer. Consult the specifications of the mass photometer
used for data acquisition in the respective user manual.
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Automatic Mode

In Automatic mode the regions are automatically assigned based upon:

* The empty capsid mass in kDa
* The transgene size in kb

These values can be specified in Acquire™” when the movie is recorded, in which case they are automatically
read by Discover'. If these values were not provided by Acquire™”, or are they are incorrect, they can also
be specified in Discover™" by pressing AAV Parameters..., which brings up a dialog in which new values
can be entered. The user can choose to directly specify the full capsid mass instead of specifying a transgene
length. On clicking OK the AAV limits will be automatically re-calculated.

Automatic calculation of the AAV regions is done as follows:

First, the range surrounding the provided empty capsid mass is analysed to detect the presence of a peak. If
a peak is successfully fitted and the fit is deemed good enough, it serves as the basis for drawing the region
centred on the peak. The width of this region depends on the peak’s standard deviation and the Auto AAV
region width setting in Preferences. In the absence of a successfully fitted peak, the region is centered on the
provided empty capsid mass, with a fixed width of 120 kDa multiplied by the Auto AAV region width.

Next, a peak is sought around the expected full mass, calculated using the provided transgene length if appli-
cable. This peak is forced to have the same standard deviation as the empty peak, provided an acceptable one
was found. The full peak is used in a similar way to define a region, based on the standard deviation and the
Preferences setting. If no peak can be fitted, a region is drawn around the provided full capsid mass, with a
fixed width of £120 kDa multiplied by the Auto AAV region width.

Particles between the empty and full regions are classified as partial.

s~ The method used to fit peaks to the histogram in this algorithm is specially suited to AAV
- @ = data and is therefore not the same as the method used for Peak Fitting on the Discover™”
;" N histogram.

Virus titer estimate

The titer estimation feature can be accessed by pressing the designated “Show titer estimates” checkbox within
the software. This is only available with movies from a Samux™.

Instructions for best results:

* The software is most accurate when used with samples that have a particle count between 500 and
1500 for a 1 minute movie

* Use a clean buffer without any surfactants or other inclusions to prepare the sample for analysis

* Use (partially) purified samples

* |t is recommended to repeat measurements to obtain a more accurate titer estimate
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Refining the data

The user can manually exclude movie frames and events that should clearly be omitted from the data analysis.
These may include frames where there has been a physical disturbance to the instrument, areas of the movie
image which display excessive underlying noise, and events that are clearly outside the expected range of
protein masses within an experiment. This functionality is only available for Normal, AAV and Antibody
Stability modes.

Temporal selection

This feature is not available for measurements taken on Samux""". If there is a physical disturbance during

movie recording, the movie may show high noise images. An example of a noisy ratiometric frame is shown
in Figure 10.

Figure 10: A comparison of a regular (above) and a noisy (below) ratiometric frame

To exclude a number of frames, hold down the left mouse button and drag over the region to be excluded

in the score graph. This action produces a purple overlay for the frames that are excluded and updates the
Selections Panel to reflect the excluded events.
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Sharpness Saturation Brightness Signal Motion

Frame Number

Frame Seconds 100 FPs 50 P Play

Figure 11: Signal score graph with removed frames indicated in purple

1
> . .
__ As frames are excluded, the related event counts are removed from the histogram. It is a

A=/~ good idea to watch the histogram to observe how much the plot changes.

The temporal mask can be deleted, either by right-clicking on the Score graph and clicking Clear Selection
or by selecting Clear in the Selections Panel in the time mask tab (see Figure Figure 12). The mask can be
inverted (using the Invert button) so as to include only events in the selected region(s) in the data analysis.
The mask can be disabled (i.e. shown but not applied) by unticking the Apply button.

Temporal mask Selected 171/171 (100.

Apply Invert Clear

Spatial Temporal Meighbour

Figure 12: Selections Panel contains information about total binding and unbinding
counts, as well as spatial, temporal, and nearest neighbour masking

Spatial selection

Feature not available for measurements taken on Samux"". The aim of mass photometry experiments is to
deliver meaningful movies for data analysis. However, on occasion, there may be a region or small area of the
movie image which shows high noise or is in some way visibly erratic. Such an area can be removed using a
spatial mask.
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Figure 13: Image area selected for spatial masking shown in purple

The spatial mask selection may be made on any frame by pressing and holding the left mouse button and
dragging over the region to be removed. This region will then be removed for all frames in the movie. Multiple
regions may be selected for spatial masking.

Similar to the temporal mask, multiple regions may be selected. The mask may be cleared, inverted and
disabled using the buttons in the Selections Panel.

The spatial mask tab of the Selections Panel holds information, including an indication of the number of events
that are currently selected and used for the histogram plot.
s =+ When applying a spatial mask, the data points arising from that region of the movie are
- = removed from the histogram. If the spatial mask is inverted, the related data points are
’ N . .
- included and all other events (outside the mask) are removed.

The event distribution can be used to show potential regions to remove (found by right-clicking on the Movie
Panel and then checking Distribution). If the orange overlay shows clear hotspots, these regions may be a
candidate to be removed. Ideally, the orange overlay should be fairly homogeneous.

Nearest neighbour selection

The Nearest Neighbour tab allows you to adjust the minimum allowable distance (in pixels) between neigh-
bouring events. Events that are closer together than the set value will be removed from the histogram.

Calibration

Precise calibration of the contrast value and mass of a protein or length of a nucleic chain is required for
accurate calibrated value determination. This procedure is performed during instrument installation and is
repeated periodically at a frequency to suit the needs of each user. It is recommended that a calibration is
performed before measurements requiring high calibrated value accuracy.

The calibration relies on measurements of several proteins of known mass/nucleic acid length, or a standardised
protein mixture. Full details of the laboratory procedure can be found in the user manual for the mass
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photometer. This section of this manual assumes that the correct steps have been taken to measure a set of
proteins on one of Refeyn’s mass photometers.

After analysing a calibrant measurement in Discover'™", histogram peaks are observed at the expected positions
on the contrast axis. The peaks can be labelled with either vertical lines, interval regions or Gaussian fits
(Gaussian fits in histogram mode only).

Creating a calibration

Clicking the Create button found in the Calibrations Panel will open the calibration dialog. The user is
initially prompted to choose the calibration type from the following options:

¢ mass calibration
* single-stranded nucleic acid calibration
¢ double-stranded nucleic acid calibration

Next, the user is asked to choose which measurements to use for the calibration. Any measurement which
has Gaussian fits, vertical lines or intervals drawn on its histogram can be used.

@ Calibration — ) X

Select calibration measurements

Figure 14: Select calibrant measurements

In the next step, the contrast values for each of the peaks, interval regions, and vertical lines in each chosen
measurement are shown in a table. Each peak has a corresponding drop-down box, from which the corre-
sponding known calibrant value can be chosen. If the calibrant used is not listed, select Other from the
drop-down and enter its value manually. To omit a peak from the calibration, select Unassigned instead.
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® Calibration — ) X

calibrant m

003 _Sample_1

007 Sample 2

Mass (ikDa)

Contrast

R 0990 Max. mass eror 30%

Gradient (10°/kDa): -57.91  Intercept (contrast):  0.00026

To edit the available list of calibrants, click Manage Calibrants.

Manage calibrants

86.00 kDa
172.00 kDa
256.00 kDa
344.00 kDa

3,640.00 kDa

56.00 kDa

112.00 kDa

224.00 kDa

Defaults -mrm Changes

Discover™ will fit a straight-line calibration using the points entered in the table. Two measures are used to
characterise the match between the data points and the obtained calibration:

1. Maximum error: Maximum percentage difference between the given value and the value calculated from
the calibration

2. r? coefficient of determination for the fitted straight line
1

_ Ensure that the fitted calibration curve (yellow line) is visibly a good fit to the calibration data.
~

’ If it is not, check for entry errors in the table, or repeat the calibration measurement(s).

Next, the user is asked to name the calibration. Finally, the user is shown a list of all measurements to which
the calibration can be applied. The user should tick all measurements to which the calibration should be
applied.
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® Calibration — ) X

Apply calibration to measurements

Sample 1
Sample 2
Sample 3

Sample 4

o @l

After a calibration has been created it will be automatically added to the Calibrations Panel.

Calibrations (@)
=+ Open

No calibration
mass_calibration

SSNA_calibration

DSNA_calibration

Figure 15: Calibration Panel: calibration type (mass, single-stranded nucleic acid or
double-stranded nucleic acid) is indicated by the attached icon

Applying a calibration

To apply a calibration to one or more measurements after it has already been created, first select the mea-
surement file(s) to which you wish to apply the calibration and then double-click on the calibration listed in
the Calibrations Panel.

To remove a calibration from one or more measurements, first select the measurement file(s) from which you
wish to remove the calibration and then double-click on No calibration in the Calibrations Panel.
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You should not use a calibration derived from a movie with one image size for a sample movie with a different
image size. For example, if the calibration was created from a movie recorded with the Regular image size in
Acquire™?, it should not be used for a sample movie that was recorded using the Large image size.

"_ When clicking on a measurement file, the applied calibration will be highlighted in bold. If no

A=/ calibration is applied, No calibration in the Calibrations Panel will become bold.

Managing the Calibrations Panel

To add a calibration, you can generate a new calibration or press the + Open button to open a previously
saved calibration file (.mc).

To remove a calibration from the panel, select the calibration and click the Bin icon in the Calibrations Panel.

1
_ '_ All calibrations in the Calibrations Panel will be automatically saved as calibration files (.mc)

A=/~ Wwhen saving the workspace.

Figures

Figure Types

There are 3 types of figure you can use to visualize your data:

* 2D Histogram - Displays measurement results on top of each other on one 2D graph.
* 3D Histogram - Displays measurement results spaced out on the Z axis of one 3D graph.
* Vertical histogram series - Displays measurement results, each on their own 2D graph.

Analysis | Figures Tables
+ Add Figure

Figure (1) @ Figure (2) @ Figure (3) @

Choose theme. Generate theme from figure... Edit themes...

3895 kDa I 005_measurement_4

099 kba » A 005 measurement 4
642 counts (39%)
Skewness: 0.000

5047 kDa
0123 kDa
803 counts (49%)
Skewness: 0.000

Empty: 653 nts (42.3%)
Partial: 95 nts (6.1%)
Full: 797 cfiults (51.6%)

Ambiguous unts (0.0%)

Figure (1)
s units

X limits - 7000.000 Auto

' apn | is u

T
3000 4000 5000 6000 Y limits 0.000 - 81600 Auto
Mass [kDa]

Figure 16: Figures Panel
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Generating a new figure

Figures can be generated using one or multiple measurement files opened in the workspace. To generate
a new figure, go to the Figures Panel > Add Figure > 2D histograms, 3D histograms or Vertical
histogram series. More than one figure can be created in the same workspace.

Once a figure is generated, the Setup section is selected by default. Here you can define the figure title and
the limits and units of its axes. Changing the figure title under Setup will automatically change the name on
the figure tab. Figure setup can be accessed at any time by pressing Setup.

* Title: Histogram title
» X axis units: Ratiometric Contrast, Mass ([kDa] or [MDa]), Bases, or Base Pairs
» X axis limits: Minimum and Maximum
* Y axis units: Counts, Normalised Counts, Density (KDE), or Normalised Density (KDE)
* Y axis limits: Minimum and Maximum
1
__ Please note that, upon choosing X axis units other than Ratiometric Contrast, only those
A=/~ measurements calibrated with the appropriate calibration type will be displayed in the figure.

Defining a figure

Under Style, you can define which elements will be displayed in the figure and can edit its formatting. After
selecting an item under Style, formatting options will be displayed in the panel below. You can also remove
elements (such as the title) from the figure by ticking or unticking them.

Formatting options available for figures:

* Figure: Background colour; figure size

 Title: Font type, colour and size

» Axes: Font type, colour and size; Major and minor ticks; Histogram depth and Histogram distance (3D
histograms)

» Labels: Font type, colour and size, label content, Rotation (2D histograms and vertical histogram series)

* Grid: Axis of grid, thickness, position and colour of grid lines

* Legend (only stacked histogram): Font type and size; legend title

A Y 4
__ Formatting of labels will apply to labels for all overlays: vertical lines, interval regions, Gaus-
mf/\ sian fits and AAV limits.

4

Adding and removing measurement files

To add one or more measurements to a figure, select the measurement files in the Measurements Panel,
then drag and drop the files into the setup section on the right-hand side of the Figures panel. To remove a
measurement file, right click and select Remove or press the delete key. Measurement files removed from
the workspace will automatically be removed from the Figures Panel.

The relative position of the plots in the figure can be changed by changing the order of the listed measurement
files in the Figures Panel. The order of measurement files can be changed by dragging and dropping the files
or by right-clicking and choosing the relevant option.

Refeyn Discover™” User Manual e Page 28



Formatting individual measurements

Each measurement file added to a figure will show a list of its associated overlays (vertical lines, Gaussian
fits, intervals and AAV limits). By default, all overlays will automatically be shown in the figure. Please note
that overlays must first be created in the Analysis Panel. Removing an overlay from the Analysis Panel will
automatically remove it from the Figures Panel as well. An overlay can be removed from the figure by unticking
it in the list. This will have no impact on the Analysis Panel.

Formatting options available for individual datasets:

» Histogram: fill colour, line pattern, line colour, line thickness

* Gaussians: peak line colour, peak line thickness, combined line colour, combined line thickness, label
colour

* Vertical lines: line colour, line thickness, label colour

¢ Intervals & AAV limits: fill colour, label colour

Figure themes

Figure settings can be saved as a theme and edited in the Histogram Themes Editor which can be accessed
by pressing Edit themes in Figures Panel. The editable features are the same ones listed in Defining a figure.
If you want to generate a theme from an already made figure, you can select Generate theme from figure.
This will automatically populate all the settings of a new theme using those explicitly used for the current
figure. The themes can be shared by using export and import theme. When setting a theme as default, every
new figure will automatically have those settings applied. To apply a previously saved theme you can select a
theme under Choose theme.

New... Rename... Delete Figure Title AXes Labels Grid Legend Colours

Import... Export... Make default
Font Calibri

Refeyn <default> _
Custom 2 Font size 10

Custom 1 Colour

X major ticks (approx)
X minor ticks (per major)
Y major ticks (approx)
Y minor ticks (per major)

Histogram depth (3D)

Figure 17: Histogram Themes Editor dialog
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Tables

Generating a new table

Tables can be generated using one or multiple measurement files opened in the workspace. To generate a new
table, go to the Tables Panel > Add Table > pdf - limited to 24 measurements or csv - unlimited
measurements. More than one table can be created in the same workspace.

The columns of both the pdf and csv table are customisable and can be saved as a template. The column
options contain all the histogram overlay information as well as additional information for making decisions
about the data.

Both the column and the row order of the tables can be changed by changing the order in the Added columns
panel and the Added measurements panel respectively.

Analysis Figures  Tables BiReport
~+ Add Table ¥ hExport v

Table (1) @ Table () © Table (3) @

Page 10f 1 Q  Table(n

Available measurements Added measurements

Table (1)

Measurement Name Time and date Image size Acquisition mode

001_cal_BAM 2022_07_08-13_34_08 Regular Normal

002_measurement_1 2022_07_08-13_34_08 Regular Normal

Add all measurements Remove all measurements

003_measurement 2 2022_07_08-13_34_08 Regular Normal

ilable columns Added columns

004_measurement 3 2022_07_08-13_34_08 Regular Normal

& Acquisition mode
c €= Binding Counts
005_measurement 4 2023,07_31-12_01_06 & somple

€ Buffer

le

Add all columns Remove all columns

Select template Save as template

Figure 18: Tables Panel

Saving and exporting

Saving workspaces

After running the analysis, a full record of the measurement files, analysis results, figures and tables generated
can be saved in the form of a Workspace. To save a workspace go to File > Save Workspace. This will
open a dialog where the save location can be chosen. The workspace consists of a folder containing:

* A workspace file (.dmp)

* A calibration folder, containing all the calibration files (.mc)

* One or more mass photometry results files (.mpr), one for each measurement file opened in the
workspace
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Exporting a figure or table

To export a figure from the Figures Panel or table from the Tables panel, press the Export button located at
the top-right of the panel. This will open a dialog where you can choose to export the current figure or table
or all figures or tables and a file format. You can choose to save figures as PNG, SVG, PDF or EPS and tables
as CSV or PDF.

Exporting Summary report

To export a PDF report combining PDF tables and figures press the Report button found at the top right
of the Discover™” window. In the Summary report dialog there is the option to choose which tables and
figures to include and in which order. There is as well an option to include comments in the Notes field.
When finished, press Generate PDF. This will open a dialog where you can choose the save location and
filename.

Exporting results and analysis data

To export data related to individual measurement files, right-click on the measurement file, then press
Export and select one of the following export options:

* Results

* Events

* Report

* Movie

* Figure

* Scores

* Raw frames; Native or Ratiometric

Batch export is also possible by selecting multiple measurements, instead of a single measurement, before
right-clicking to access the export option.

Export options

Results - Exports individual measurement results files (.mpr). This will open a dialog where the save location
can be chosen.

N ! U4

_.@_ Mass photometry results files (.mpr) will automatically be generated when saving the entire
A=/ workspace.
-

Events - The mathematical algorithm for finding binding and unbinding events is a two-stage process that first
detects step changes of the glass reflectivity and then assesses whether the respective peak in the ratiometric
image matches the expected signature. The original data generated by this algorithm can be exported as a
.csv or .h5 file.

Report - A single measurement report detailing the acquisition and analysis settings for a given set of results
can be exported. This will bring up a window showing the value of every setting. The right-hand “Description”
column can be removed by unticking the box at the top of the dialog labelled Include descriptions. To save
the report, press the Export button and choose a file format. Reports can be saved as PDF, CSV or JSON.
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Include descriptions Export ¥

Analysis

Info

Analysis ID 0 11bc Unique identifier for the analysis.

Analysis creation time 3117:12:3 The time at which the analysis
created.

Analysis modification time 311 3 The time at which the analysis was
last modified.

Comments Comments about th
measurement.

Data analysis software version Refeyn DiscoverMP 2024.1.0a2 Data analysis software version that
was used.

Results

[ e e ]
’

Figure 19: An example of a report

Movie - Movies generated can be exported as a MP4, MOV, AVI or TIFF. When exporting a movie, an additional
dialog will open with the following options:

Movie: Which movie to export (native or ratiometric).

Start/Stop Frame: The range of frames to export.

Upscale: this causes the movie to be saved at a higher resolution (without interpolation).

* Frame Rate: the number of frames played per second.

Colormap: this shows the colours that will be used to represent high and low values.

Colorbar: when ticked this adds a colorbar to every frame of the movie to show the contrast scale.
Annotate Frames: when ticked, this adds a label to each frame indicating the frame number.

Note: TIFF format only uses the start and stop frame values. The other settings have no impact on the TIFF
format.
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Movie ratiometric
Start Frame

Stop Frame

Upscale

Frame rate / Hz
Colormap
Colorbar
Annotate Frames

Export

Figure 20: Export movie dialog

Making the movie larger using third party software (e.g. Windows Media Player), may result
: in interpolation that reduces accuracy and blurs images. It is preferable to perform this

) ’
“ operation at the time of exporting the movie. The recommended value for upscaling is 3.
’ o . . .
- The larger the upscale value, the larger the exported file will be and the longer it will take

to export.
Figure - Exports an automatically-generated histogram of an individual measurement results file (as a PNG,
SVG, PDF or EPS file). This will open a dialog where the save location can be chosen.
Scores - Data on brightness, motion, sharpness, saturation and signal can be exported as a .hb5 file.

Frames - This options allows for the export of all frames from a movie. Users can choose between exporting
ratiometric or native moves by pressing Export > Raw Frames > Ratiometric or Native as desired. This
will generate a .h5 file. Additionally, it is possible to export a single frame from a movie. For this, a users is
required to go to the Analysis Panel, right-click on the movie and press Export frame. This will export the
currently displayed frame as a PNG or PDF file.

Exporting calibrations

After a calibration is added to the Calibrations Panel, it can be exported as a calibration file (.mc) by selecting
the calibration and clicking on the Export icon, found at the top right of the Calibrations Panel.
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Additional functionality

Analysis comments

It is possible to save comments to a set of Discover™" results. When a movie has been loaded, the comments
button located in the top right corner of the Analysis Panel can be pressed. This opens a dialog with two
tabs. The first tab is Analysis. These are comments that should relate to the information from Discover™?.
The second tab is Acquisition, which displays the sample information and comments provided in Acquire™”
when the movie was recorded. These comments will be included in a generated report.

Analysis  Acquisition

Enter analysis comments...

Figure 21: Comments dialog displaying an example comment

Tooltips

Discover™ includes tooltips which may be displayed by hovering over buttons. These explain the use and

purpose of each button.

What’s this

Discover™ application includes What’sThis boxes which may be displayed by clicking the Question Mark
button (found at the top right of the window) and then clicking on a Ul element, such as a button or tickbox.
These boxes will contain detailed information about the element in question.

Analysis settings for OneMP users

One™P users have access to an additional settings dialog which enables changes to the analysis pipeline. Settings
apply to individual measurement files. To access settings, go to the File Panel, right-click on the desired
measurement file and select Settings

Analysis can be split up into two stages: the finding of events and the fitting of events.
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Finding events: The mathematical algorithm for Finding Events is a two-stage methodology that first detects
step changes of the glass reflectivity (Filter 1) and then assesses whether the respective peak in the ratiometric
image matches the expected signature (Filter 2).

Fitting events: This takes the found events and fits a Point Spread Function to the events. The position of
the best fit will become the center of the event.

The settings used for threshold 1 and 2 in the analysis have been described above. The default values should
be appropriate for most cases, but expert users may wish to adjust them. To return to the default settings at
any time, select Reset in the Settings dialog.

The value for Number of Binned Frames defines the number of native frames that are averaged during
the calculation of a single ratiometric frame. Increasing this value from 5 to 6 or 7 usually decreases noise and
enhances the sensitivity for the detection of low-mass particles. However, increasing it also leads to more
crowded ratiometric frames, especially for concentrated samples. The associated signal overlap may lower
sensitivity and mass precision.

The Reflectance Correction when ticked will apply Refeyn’s algorithm to reduce signals that can be pro-
duced by the reflection of the glass surface.

The Motion Correction when ticked will apply Refeyn’s algorithm to reduce artefacts in the ratiometric
contrast images that are an effect of the transverse motion of the microscope slide, either due to drift or an
external vibration source. The algorithm estimates the amplitude of the motion signature in the ratiometric
frame and subtracts it.

An advanced settings feature is available when selecting Advanced in the Settings dialog. We advise users to
not change advanced settings unless instructed to do so by Refeyn.

Preferences

Discover™ has a small set of preferences that the user can interact with via File > Preferences.

Telemetry mode

In the Preferences dialog, the current telemetry mode can be updated.

* Feature preview mode - Allows access to experimental features. Measurement data, and basic data
about the user’s use of the software will be anonymously reported to Refeyn, including error reports.

* Normal mode - Basic data about the user’s use of the software will be anonymously reported to
Refeyn, including error reports.

+ Offline mode - Discover™ will not communicate with the internet, or allow any feature that requires
the internet.

Other settings

With Show calibration help checked, Discover™ will show a dialog explaining how to apply a calibration
when a calibration file is opened for the first time.

MP

With Enable auto fitting for non-Samux™P movies checked, after a non-Samux"" measurement is anal-

ysed, Discover™” will attempt to automatically fit its peaks.

With Edit settings for all movies checked, Discover™ allows the user to edit analysis settings for any
measurement in the workspace. It is recommended to keep this un-checked.
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The Auto AAV region width, specified in units of standard deviation o of the peak Gaussian, guides the
auto AAV limits algorithm in defining the empty/full region boundaries.

() Feature preview mode

@ Normal mode

) Offline mode

. Show calibration help . Enable auto fitting for non-SamuxMP movies

. Edit settings for all mov

\AV region width (recommended value: 1.50

Advanced mode...

-ave preferences

Figure 22: Preferences dialog
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General information

Refeyn Ltd service and support

Refeyn Ltd offer service and technical support for our mass photometry systems, and the Refeyn software
applications:

Refeyn Ltd

Unit 9, Trade City

Sandy Lane West

Oxford

OX4 6FF

Email: support@refeyn.com

Call: +44 (0) 1865 800 175

Disclaimer

This user guide is proprietary to Refeyn Ltd and no part of this manual may be reproduced, copied or duplicated
without the express written permission of Refeyn Ltd.

The information contained in this user manual is intended solely for informational purposes and is subject to
alteration without warning and does not represent a commitment on the part of Refeyn Ltd. This user manual
has been prepared by Refeyn Ltd in good faith, through exercising due and customary care and on the basis
of information available at the date of publication and Refeyn Ltd makes no commitment to update or keep
current the information in this user guide. Refeyn Ltd reserves the right to make improvements to this user
guide and/or to the products described in this user guide, at any time without notice. For this reason, users
should not act upon any information contained herein without first consulting Refeyn Ltd.

Whilst every effort has been made to ensure that this user guide is accurate, Refeyn Ltd makes no warranty,
express or implied in relation to the contents of this document and does not guarantee or warrant the accu-
racy, reliability, completeness or currency of the information in this user guide, nor the quality, performance,
merchantability or fitness for a particular purpose of the product described herein or that the product will
work in all applications or environments. Refeyn Ltd therefore assumes no liability for any loss, damage, cost
or expense incurred or arising by reason of any person using or relying on information in this report or for
any errors, omissions or misrepresentations contained therein.

You will be solely responsible for your use and reliance on any results obtained from using Discover™". You
are also solely responsible for obtaining all necessary legal and regulatory permissions, clearances, approvals,
and authorizations required for your business. Use of Discover™" is subject to the terms and conditions in
Refeyn Ltd’s licence agreement (EULA).
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